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Spatial planning is the process of looking into the future 
and making good decisions about delivering on issues 
of development and protection.

Identifying opportunities and constraints to plan in a 
coordinated manner for change over time is essential 
to ensuring communities and the environment grow and 
change positively.

DISTRICT AND REGIONAL SPATIAL PLANNING

How are spatial plans delivered?

Spatial plans are delivered through a comprehensive 
process that involves significant investment in time and 
cost. Key inputs include the planning process itself, 
supported by strong engagement. Once the spatial plan 
is completed, a range of processes and projects are 
implemented to achieve desired outcomes.
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What is spatial planning?

Delivering positive outcomes for the community 
and the wider environment is at the heart of spatial 
planning. Spatial plans can range in size from a 
specific area (these are often called masterplans and 
may be undertaken by private-sector developers) to 
town, city, district or regional spatial plans – these 
are usually undertaken by Councils.

Spatial plans, no matter what their size, are 
forward-looking strategies for growth and change. 
The process of spatial planning identifies current 
and future opportunities and constraints to help 
make coordinated, thoughtful decisions related 
to development, use of natural resources, and 
protection of important assets and environments.

Spatial planning typically incorporates mapping to 
show inputs (existing opportunities and constraints) 
and outputs (new projects and future development 
areas). The maps and plans demonstrate a process 
of consideration and decision-making and provide 
direction through a clear visual output.

DISTRICT AND REGIONAL SPATIAL PLANNING
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What makes a good 
spatial plan?
A successful spatial plan is a strategic framework that 
guides long-term development and land use across districts 
and regions. The following principles define a robust and 
effective spatial plan.

DISTRICT AND REGIONAL SPATIAL PLANNING

Collaborative 
Effective spatial planning 

involves meaningful engagement 
with partners, stakeholders, 
and communities, fostering 

shared ownership and inclusive 
decision-making.

Process-driven 
It is grounded in thorough 

analysis, active engagement, 
and continuous evaluation, 

ensuring decisions are informed 
and responsive.

Long-term 
A visionary outlook spanning 30 years 

or more enables strategic change, 
resilience, and adaptability to future 

challenges and opportunities.

Spatial 
A good plan is coordinated 

across urban, rural, and natural 
areas, ensuring integrated 
development that respects 
ecological boundaries and  

land use diversity.

Place-based 
It reflects the unique past, 

present, and future contexts of 
each location, aiming to enhance 

liveability and identity through 
tailored planning approaches.

Prioritised 
Identifying early wins, enabling 
actions, and transformational 

projects helps build momentum and 
deliver tangible benefits. Identifying 

priority development such as key 
infrastructure provision and removing 

blockages to positive change  
and growth.

Documented 
Transparency is key; plans should 
be supported by a clear evidence 

base and rationale that can be 
communicated and understood by all.

Urban form and  
infrastructure provision 

Optimal integration of land use and 
infrastructure systems supports 

sustainable growth, accessibility, and 
efficient provision of services.

Adaptable 
The plan must accommodate different 

scenarios, with mechanisms for 
monitoring, review, and adjustment  

to stay relevant over time.

Directive but flexible 
Spatial plans need to provide 

clear strategic direction that will 
direct regulatory plans and council 

processes; but also need to be flexible 
to allow for structure and master 

planning at more detailed scales to 
respond to local needs and  

changing conditions.

 SWIPE 



5  DISTRICT AND REGIONAL SPATIAL PLANNING

INPUTS

DISTRICT AND REGIONAL SPATIAL PLANNING

Inputs to a spatial plan are any existing constraints and opportunities. This includes objective data, such 
as demographic and geographic information; and existing infrastructure, like roads and utilities. Spatial 
planning inputs also include studies and analysis that inform and impact guide the spatial planning 
process, such as:

• Landscape and Coastal Natural Character Studies  • Ecological Assessments and identification of Significant 
Natural Areas • Cultural Assessments • Community Engagement • Existing legislation, statutory plans,  
or policy statements also influence and inform spatial plans

Natural Character of  
the Marlborough Coast► Connecting Future  

Dunedin Transport► Waikawa Integrated  
Catchment Management Plan► Stewart Island Natural  

Character Study► Auckland East-West  
Transport Study►
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https://www.boffamiskell.co.nz/projects/natural-character-of-the-marlborough-coast
https://www.boffamiskell.co.nz/projects/connecting-future-dunedin-transport
https://www.boffamiskell.co.nz/projects/waikawa-integrated-catchment-management-plan
https://www.boffamiskell.co.nz/projects/stewart-island-landscape-and-coastal-natural-character-study
https://www.boffamiskell.co.nz/projects/auckland-east-west-transport-study
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INPUTS

DISTRICT AND REGIONAL SPATIAL PLANNING

Boffa Miskell has a long history of assisting Councils with studies and analysis that inform the spatial 
planning process. This work involves our core disciplines, including landscape planning, ecology and 
biosecurity, planning and transport planning, cultural advisory, engagement, and nature and climate 
change, assisted by our GIS specialist team.

Our cross-disciplinary expertise means that spatial planning inputs can be comprehensively addressed in 
an integrated and coordinated manner. The Boffa Miskell team can assist you in understanding complex 
matters that need to be addressed in the spatial planning process. 

Tauranga Residential Intensification  
Landscape Assessment for Plan Change 33► New Plymouth  

District Plan Review► Waikato District  
Landscape Study► Hauraki Plains Adaptation  

Plan – Social Impact Assessment►
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https://www.boffamiskell.co.nz/projects/tauranga-residential-intensification-landscape-assessment-for-plan-change-33
https://www.boffamiskell.co.nz/projects/new-plymouth-district-plan-review
https://www.boffamiskell.co.nz/news-insights/waikato-district-landscape-study
https://www.boffamiskell.co.nz/projects/hauraki-plains-adaptation-plan-social-impact-assessment
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SPATIAL PLANNING PROCESSES

DISTRICT AND REGIONAL SPATIAL PLANNING

We regularly work with other specialist teams in relation to natural hazards, infrastructure and demographics, with 
our engagement specialists assisting with the facilitation of community input. This inter-disciplinary approach means 
that complex issues can be comprehensively addressed through the spatial planning process, taking into account key 
aspects such as managing population growth and natural hazard risks.

Kaikōura Spatial Plan► Te Tapuae Southern  
Corridor Structure Plan► Ohakune Spatial Plan► Richmond Spatial and  

Intensification Plan► Te Pātukurea Kerikeri  
Waipapa Spatial Plan►
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https://www.boffamiskell.co.nz/projects/kaik-ura-spatial-plan
https://www.boffamiskell.co.nz/projects/te-tapuae-southern-corridor
https://www.boffamiskell.co.nz/projects/ohakune-spatial-plan
https://www.boffamiskell.co.nz/projects/richmond-spatial-plan
https://www.boffamiskell.co.nz/projects/te-patukurea-kerikeri-waipapa-spatial-plan
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► Christchurch Central Recovery Plan Blueprint
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https://www.boffamiskell.co.nz/projects/christchurch-central-recovery-plan-blueprint
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SPATIAL PLANNING PROCESSES

DISTRICT AND REGIONAL SPATIAL PLANNING

The spatial planning process incorporates constraints analysis to identify environmental, cultural, and 
physical limitations. Through the designation of land uses and the layering of key systems, such as 
Blue-Green Networks, transport, and infrastructure, a spatial plan creates a coherent framework for 
sustainable development over a period of years or decades. 

Mackenzie Spatial Plans► Teviot Spatial Plan ► Thames and  
Surrounds Spatial Plan►

QUEENSTOWN LAKES DISTRICT COUNCIL │  DRAFT BLUE GREEN NETWORK PLAN │ LOCAL BLUE GREEN PLANS

48

WĀNAKA NORTH14

ID PROJECTS DESCRIPTION

14.01 Lake Wānaka 
Foreshore

Riparian planting of Lake Wānaka.

14.02 New Park Additional community park and local park.

14.03 New Park Additional community park.

14.04 Scurr Heights Active Trail connecting Wānaka Central to 
Beacon Point.

14.05 Te Waiatakaia | 
Mount Iron

Wildfire breaks and trails. 

LAKE WĀNAKA

Eely Point 
Reserve

Wānaka 
Primary 
School

Te Kura O Tititea Mount 
Aspiring College

Wānaka Yacht Club

Lismore   
Park Mt Iron

Ruby Island

Northlake

14.01

14.02

14.03

14.04

14.04

LEGEND
WATERWAYS - EXISTING

WATERWAYS - PROPOSED

WATERWAYS - APPROXIMATE 
LOCATION

WETLAND - EXISTING

FISH LADDER - PROPOSED

ECOLOGY - EXISTING

ECOLOGY - PROPOSED

ECOLOGY - APPROXIMATE 
LOCATION

PARKS - EXISTING

PARKS - PROPOSED

PARKS - APPROXIMATE 
LOCATION

DESTINATIONS - EXISTING

DESTINATIONS - PROPOSED

ARRIVAL NODES - EXISTING

ARRIVAL NODES - PROPOSED

TRAILS - EXISTING

TRAILS - PROPOSED ROUTE

TRAILS - APPROXIMATE 
ROUTE

Figure 59: Wānaka North Local Blue Green Plans

Pembroke 
Park

Roys Bay

Deans 
Bank

14.05
Lismore Jump Bike Park

The Priority Area is surrounded by Lake Wanaka, Mata-Au | Clutha River 
outlet and Mount Iron. These provide access to an extensive trail network 
and a wide range of recreational areas. Lismore Park and Mt Iron provide 
the primary open space resource within the Priority Area.   

The Priority Area includes established residential areas with limited 
and unevenly distributed parks, particularly in the lower density, 
northern parts. Emerging greenfield developments do provide more 
comprehensively planned open spaces and trail connections for their 
more intensive urban development. Although, a considerable amount of 
greenfield land remains where stormwater management and the parks 
will be important to service projected housing growth. The ecological 
restoration and trail connectivity along the Lake Foreshore and River 
terraces are other areas of focus. While Mt Iron has extensive areas of 
indigenous vegetation, wildfire management in an ongoing concern.

D R A F T

Queenstown Lakes  
Blue-Green Network Plan► Vincent Spatial Plan►
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https://www.boffamiskell.co.nz/projects/mackenzie-spatial-plans
https://www.boffamiskell.co.nz/projects/teviot-valley-spatial-plan
https://www.boffamiskell.co.nz/projects/thames-and-surrounds-spatial-plan
https://www.boffamiskell.co.nz/projects/queenstown-lakes-blue-green-network-plan
https://www.boffamiskell.co.nz/projects/vincent-spatial-plan
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IMPLEMENTATION

Once a spatial plan is in place, there are a range of ways  
in which it is integrated into Council business and 
regulatory functions.

For Regional Spatial Plans it is likely the key 
implementation methods will be through regulatory plans 
(the new forms of regional and district plans) as well as 
through Long-Term Plans and Regional Land Transport 
Plans. There will also be a range of other implementation 
methods such as smaller-scale area and development 
plans, reserve management plans, and infrastructure plans.

Discrete projects can also be part of implementing a spatial 
plan, in response to specific identified opportunities or 
issues. These could include a streetscape upgrade in 
the town centre to accommodate a changing population, 
designating areas that will be set aside for development or 
protection, or undertaking a longer-term staged programme 
of infrastructure improvements.

DISTRICT AND REGIONAL SPATIAL PLANNING

► Taupō Town Centre Transformation
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https://www.boffamiskell.co.nz/projects/taup-town-centre-transformation
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IMPLEMENTATION

DISTRICT AND REGIONAL SPATIAL PLANNING

The Boffa Miskell team has considerable experience in assisting with the design and development of 
these implementation tools, particularly in the development and change of district and regional plans, 
management plans and infrastructure planning projects.

Feasibility Study of Nature-based 
Solutions for Flood Hazards► National Medium  

Density Design Guide►

UP TO 700,000 PEOPLE

NTS

Mass Transit Network

Station

Core public transport routes

New / enhanced public transport routes

Potential future public transport links

Heavy rail line

Significant urban centres

Major towns

Locally important urban centres and towns

Growth around central city, centres and corridors

Kāinga Nohoanga/Papakāinga

Hospital

University / polytech

Ecological enhancement  / green belt

Existing ecological patches / corridors

New / expanded industrial areas

Existing urban area

Approved plan change not yet operative

Future urban development areas and private plan 
changes made operative and available  
for development. (May include some already zoned land)

LEGEND

“Note that ‘new/enhanced public transport routes’ refers to an increase in the 
frequency of bus services. No changes are proposed to these road corridors. 
The safe connectivity of the Kāinga Nohoanga Zones (Māori Reserve Land) 
to the wider transport network is a priority.

Greater Christchurch  
Spatial Plan Mapping ►
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Source: Esri, DigitalGlobe, GeoEye, i-cubed, USDA, USGS, AEX, Getmapping, Aerogrid, IGN, IGP, and the GIS User Community

South Taranaki  
District Plan Review► Penlink  

Environmental Advisory►
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https://www.boffamiskell.co.nz/projects/feasibility-study-of-nature-based-solutions-for-flood-hazards
https://www.boffamiskell.co.nz/projects/national-medium-density-design-guidelines
http://www.boffamiskell.co.nz/projects/greater-christchurch-spatial-plan-mapping
https://www.boffamiskell.co.nz/projects/south-taranaki-district-plan-review
https://www.boffamiskell.co.nz/projects/penlink-environmental-advisory
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►Mid Dome Wilding Trees Eradication Programme

Te Aka Raataa Regeneration  |  Rev A  |  March 2024 | 10

Developed Design  |  Te Aka Raataa Regeneration

MAANGERE

MANUREWA

WIRI

ONEHUNGA

TE MAANUKA

TE MAANUKANUKA 
O HOTUROA

TE TAI-O-REEHUA

TAAMAKI STRAIT

Puhinui Catchment

MAnAkAU HARBoUR ReCeiving enviRonMenT

1. Reference 1
2. Reference 2

Scale: 1_200 000@A3

0 2 10 20KM

Te Aka Raataa

keY
Site Location
Auckland Council Boundary
Manukau Receiving 
Environment Boundary

Streams

► Te Aka Raataa | Vine Stream Puhinui Stream Regeneration Stages 1 and 2

► Aotearoa Urban Street Planning and Design Guide
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https://www.boffamiskell.co.nz/projects/mid-dome-wilding-trees-eradication-programme
https://www.boffamiskell.co.nz/projects/te-aka-raataa-vine-stream-puhinui-stream-regeneration-stages-1-and-2
https://www.boffamiskell.co.nz/projects/aotearoa-urban-street-planning-and-design-guide
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IMPLEMENTATION

DISTRICT AND REGIONAL SPATIAL PLANNING

Te Kirikiri |  
Frankton Masterplan► Predator Free Pēwhairangi 

Whānui Eradication Strategy► Lake Māhinapua  
Management Plan► Greater Wellington Pre-1930s 

Character Area Review► Rolleston Town  
Centre Masterplan►
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https://www.boffamiskell.co.nz/projects/te-kirikiri-frankton-masterplan
https://www.boffamiskell.co.nz/projects/predator-free-pewhairangi-whanui-eradication-strategy
https://www.boffamiskell.co.nz/projects/lake-mahinapua-management-plan
http://www.boffamiskell.co.nz/projects/pre-1930s-character-area-review
https://www.boffamiskell.co.nz/projects/rolleston-town-centre-masterplan
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► Sandy Point Domain Masterplan

► Northern Gateway Toll Road

LEGEND 
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Based on indicative walking circles of 400m two new neighbourhood 
parks should be considered within the Carrington Site; to the north and 
central areas. These previously identified areas within the framework 
plan to the centre of the site and to the north of the former Carrington 
Hospital building are well located to serve the anticipated new residential 
community as well as to help connect the site to the surrounding 
community.
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OPEN SPACE PROVISION

► Carrington Development
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https://www.boffamiskell.co.nz/projects/sandy-point-domain-masterplan
https://www.boffamiskell.co.nz/projects/northern-gateway-toll-road
https://www.boffamiskell.co.nz/projects/carrington-development
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IMPLEMENTATION

DISTRICT AND REGIONAL SPATIAL PLANNING

Tūpuna Maunga o Tāmaki Makaurau 
Integrated Management Plan► Katikati Town Centre  

Plan & Community Plan► Chorus Ultra-Fast  
Broadband Consenting► Ōtākou Regional  

Planting Strategy► Pegasus Town►
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https://www.boffamiskell.co.nz/projects/tupuna-maunga-strategies
https://www.boffamiskell.co.nz/projects/katikati-town-centre-plan-and-community-plan
https://www.boffamiskell.co.nz/projects/chorus-ultra-fast-broadband-consenting
https://www.boffamiskell.co.nz/projects/takou-regional-planting-strategy
https://www.boffamiskell.co.nz/projects/pegasus-town
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► Drury South Crossing Stormwater Wetland One

► Waterview Connection

► Waipa District Structure Plans
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https://www.boffamiskell.co.nz/projects/drury-south-crossing-stormwater-wetland-one
https://www.boffamiskell.co.nz/projects/waterview-connection
https://www.boffamiskell.co.nz/projects/waipa-district-structure-plans
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IMPLEMENTATION

DISTRICT AND REGIONAL SPATIAL PLANNING
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Wairarapa Floodplain  
Management Plans► Three Waters Review Reports► Wairakei to Whakamaru New 

220kV Transmission Line► New Zealand Battery Project►Kōwhai Park Solar Farm►
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https://www.boffamiskell.co.nz/projects/wairarapa-floodplain-management-plans
https://www.boffamiskell.co.nz/projects/three-waters-review-reports
https://www.boffamiskell.co.nz/projects/wairakei-to-whakamaru-new-220kv-transmission-line
https://www.boffamiskell.co.nz/projects/new-zealand-battery-project
https://www.boffamiskell.co.nz/projects/kowhai-park-solar-farm


18  DISTRICT AND REGIONAL SPATIAL PLANNING

► Arowhenua Reserve Regeneration Plan

► White Hill Wind Farm ► Ōruaka Pā Historic Reserve Management Plan
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https://www.boffamiskell.co.nz/projects/arowhenua-reserve-regeneration-plan
https://www.boffamiskell.co.nz/projects/white-hill-wind-farm
https://www.boffamiskell.co.nz/projects/ruaka-pa-historic-reserve-management-plan
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IMPLEMENTATION

DISTRICT AND REGIONAL SPATIAL PLANNING

Rangiuru Business Park► Mangere BNR Wastewater 
Treatment Plant► Ruakura Superhub► Tauriko Business Estate Stage 4  

Private Plan Change | PlanChange 35►Burnham Quarry►
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https://www.boffamiskell.co.nz/projects/rangiuru-business-park
https://www.boffamiskell.co.nz/projects/mangere-bnr-wastewater-treatment-plant
https://www.boffamiskell.co.nz/projects/ruakura-superhub
https://www.boffamiskell.co.nz/projects/tauriko-business-estate-stage-4
https://www.boffamiskell.co.nz/projects/burnham-quarry
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WHANGĀREI-TERENGA-PARĀOA

 
AUCKLAND /  
TĀMAKI-MAKAURAU

HAMILTON /  
KIRIKIRIROA

TAURANGA /  
TAURANGA-MOANA

 

WELLINGTON /  
TE WHANGANUI-A-TARA 
 
NELSON /  
WHAKATŪ 

 
CHRISTCHURCH /  
ŌTAUTAHI

QUEENSTOWN /  
TĀHUNA 

DUNEDIN /  
ŌTEPOTI

Boffa Miskell is a leading New Zealand 
environmental consultancy with nine 
offices throughout Aotearoa. We work with 
a wide range of local and international, 
private and public sector clients in the 
areas of planning, urban design, landscape 
architecture, landscape planning, ecology, 
biosecurity, Te Hīhiri (cultural advisory), 
engagement, transport advisory, climate 
change, graphics and mapping. 

50+
years

9 
offices

200+
whanau

11
services

DISTRICT AND REGIONAL SPATIAL PLANNING

ACROSS THE MOTU
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TOGETHER. SHAPING BETTER PLACES

Scan QR code to view on your device
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